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GoLive CyberStudio Try Out Manual

     
GoLive CyberStudio 
Try Out Manual

Welcome to GoLive CyberStudio, the complete solution 
for HTML layout, design and Web site management. It 
gives Macintosh users unprecedented creative control 
and flexibility when designing a Web site. GoLive Cyber-
Studio lets graphic designers and publishers visually de-
sign and manage a professional-quality Web site—
including the latest multimedia features—without per-
forming any HTML programming. Yet, GoLive CyberStu-
dio also includes HTML source-code and JavaScript tools, 
which help Web designers and programmers integrate 
interactivity into a site.

How to Navigate through this Manual

This short reference manual contains seven main sections with short descriptions of Cyber-
Studio’s features:

• What’s New, What’s Hot? (see page 6 and following)

• Three Plus Two Document Views (see page 9 and following)

• The Palette and Inspector Windows (see page 12 and following)

• Previewing Your Work (see page 26)

• The Color Picker (see page 27)

• Managing Web Sites (see page 28 and following)

• Project Preferences (see page 34 and following)

Throughout this manual, look for the GoLive CyberStudio program icon to learn more 
about the striking new features built into GoLive CyberStudio.
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What’s New, What’s Hot?
GoLive CyberStudio contains virtually everything graphic artsists and professional publish-
ers are looking for in a Web publishing package. GoLive CyberStudio goes well beyond the 
scope of basic WYSIWYG editors and gives you a set of fine tools that will really boost your 
productivity.

Be it layout or raw HTML code, GoLive CyberStudio offers the best of both worlds, and it 
sports the outline editor, a unique feature not found with any competing product. A simple 
mouseclick suffices to switch between document views or preview your page.

Add to this sophisticated graphical site management capabilities, comprehensive multime-
dia and animation technology support, a wide selection of color options, throw in a new 
editing environment that has been designed for maximum ease of use, and you’ll get a 
good impression of the power GoLive CyberStudio has to offer. 

The GoLive CyberStudio Screen

The following sections outlines GoLive CyberStudio’s major features and gives hints where 
to find instructions how to use them.
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HTML Layout 

So far, so good. But what makes GoLive CyberStudio really stand out from other Web au-
thoring tools? Well, GoLive CyberStudio is the first HTML-based authoring software to allow 
you to visually layout Web pages with full graphical control. GoLive CyberStudio does away 
with the limits imposed by other Web editors and saves you precious time and guesswork. 

In fact, GoLive CyberStudio works much like a desktop publishing program. It lets you drag 
objects from the Palette onto your page and position them exactly where you want them 
to be displayed by the Web browser. For instructions, see "Layout Grids" on page 15.

Built-In JavaScript Editor

GoLive CyberStudio offers more than just simple Java support. A full-fledged JavaScript ed-
itor with a comprehensive class and method library supports easy drag & drop script build-
ing. For instructions, see "Java Scripts" on page 13.

WorldScript Support

GoLive CyberStudio uses WorldScript™, Apple’s proprietary system extension for multi-lan-
guage documents, to let the user build Web pages that can be read by Web surfers world-
wide. The screenshot below shows a selection of supported one-byte and two-byte code 
scripts. Scripts are supported with byte lengths of 7 and 8 bits to avoid readability problems 
caused through truncation of the eighth bit by non-Macintosh Web servers.

Script Systems Supported by GoLive CyberStudio

AppleScript Support

GoLive CyberStudio’s Source mode provides comprehensive support for AppleScript™, Ap-
ple’s proprietary tool for automating repetitive tasks running on Macintosh computers. 
AppleScript support extends well beyond the Required Suite, allowing experienced users to 
automate Web page creation.

HotSauce Support

GoLive CyberStudio can write Apple’s proprietary Meta Content Format (MCF). When fin-
ished writing, it lets you view the result in the Inspector window or in an MCF file window.

Select a Script from the File menu, then type in the 
foreign language of your choice. 
(Requires the proper font and specific settings in the 
Preferences window.)
7
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Point & Shoot

GoLive CyberStudio features Point & Shoot, a proprietary technology developed by GoLive 
Systems. Point & Shootis a revolutionary feature designed to make link creation more intu-
itive and help you increase your productivity.

You start to Point & Shoot at the following origins:

• from the Point & Shoot button, labeled “@", in various Inspector windows;

• from any selected item, for example text or an image, by Command-clicking and dragging;

• from any frame in the Frames view;

… and link to the following destinations:

• to any object in the Project window

• to any appropriate location in a document window, simultaneously inserting an anchor;

• to the page icon at the top of the document window, located right beneath the four view 
switching tab riders. This option is only available in the Layout view.

After attaching the link, you will receive visual feedback. If successful, the link will flash like 
a selected menu item. If unsuccessful, the link will recoil and wind up back to its origin.

Point & Shoot Action and Point & Shoot Locations

Drag a link from this Image Map Region …

Drag a link from from the Point & Shoot button…

… to the page icon at the top of the document window.

… to any object in the Project window.
8
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Three Plus Two Document Views 
GoLive CyberStudio offers three different document views to choose from, plus a Frames 
mode for those who prefer frames to structure their pages (see "Frames and the Frames 
View" on page 25) and a Preview window (see "Previewing Your Work" on page 26). Each 
view has its own tab, which can be selected by simply clicking the desired tab rider.

Layout

The Layout mode lets you view and edit your document in WYSIWYG mode, giving you a 
realistic impression of how the page will look when viewed with a Web browser.

The Layout View

Most of the editing work is done in the Layout view. You can drag objects from the Palette 
and drop them in the document window, then “tweak” HTML tag options for best results 
using tag-sensitive Inspector windows. drag & drop support is also ensured for images and 
media items from the Finder or Project window, URLs and addresses from the Project win-
dow and colors from the Color Picker.

For more details, please refer to the description of the Palette, Inspector, Project and Color 
Picker windows later in this document.

Click this tab rider to select the 
Layout view.
9
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Outline

The Outline mode lets you view your document in the outline mode, a structured approach 
to building, fine-tuning and debugging HTML code.

The Outline View

The structure shows the hierarchy of the HTML tags in your document, using a box meta-
phor to display individual tags.  

Outline View Controls and Display Elements

Click this tab rider to select the 
Outline view.

Click this handle to drag & drop a tag element.
Click here to expand or collapse the tag element.
Click here to edit the tag name.
Click here to show or hide element attributes.
Bounding box indicates current selection.

Highest level in HTML tag hierarchy.
Indent indicates lower level in HTML tag hierarchy.

Vertical lines interconnect open and close tags.

Click here to expand or collapse the tag attribute list.
10
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Source

The Source mode lets you view the HTML code behind your document much the same way 
text Web editors do. For maximum ease of use, however, it uses a technique referred to as 
syntax highlighting. 

Syntax highlighting uses separate colors to visually separate tags, attributes and document 
content, thus making it easy on the user to keep track of his HTML code.

Consistent with CyberStudio’s philosophy, the source view provides full drag & drop support 
for the entire tag inventory offered by Body Tags tab the Palette.

This document view is particularly useful for experienced HTML programmers who wish to 
do some fine-tuning work and check out their HTML code prior to publication.

The Source View

Click this tab rider to select the 
Source view.
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The Palette and Inspector Windows
The Palette window holds a wealth of iconized tags, structural page elements and project 
management tools. Arranged in five context-specifc tabs, these fine tools ensure that Web 
page building is easy and productive. 

Accompanying each element dropped in your page is a context-sensitive Inspector window 
that relieves you of the burden of clicking OK repeatedly in multi-level dialog boxes. Upon 
insertion of a tag or other element the proper set of options pops up in the Inspector win-
dow, allowing you to set your tag options instantly.

Interaction between the Palette and Inspector Windows

Palette tabs can be selected by clicking the rider of the desired tab. The following table lists 
the symbols on the individual tab riders and explains their functions.

Symbol Function

Click this icon to select the Body Tags tab.

Click this icon to select the Forms Tags tab.

Click this icon to select the Header Tags tab.

Click this icon to select the Frames tab.

Click this icon to select the Project tab.

Dragging the Image icon from the Palette onto the document opens 
the Image Inspector (right).
12
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Body Tags

The Body Tags tab contains the tags that make up the body section of the page. Tag inser-
tion is a simple drag & drop process.

Palette Window with Body Tags Tab Selected

Java Scripts 

GoLive CyberStudio also supports Java scripting. Just drag the Java Script icon from the Pal-
ette and drop it in your document. The context-sensitive Inspector window, now titled Body 
Script Inspector, will allow you to specify a JavaScript dialect, link to an existing script or 
open the script builder window and start writing your own script. 

Java Script Icon, Java Script Placeholder and Body Script Inspector

Drag the “Duke with Script” icon 
from the Palette onto your docu-
ment.

Drop it to insert this Java script 
placeholder.

Watch the Body Script Inspector 
appear in the Inspector window.

Type in the JavaScript dialect here.

Type in the name of the JavaScript 
source file here, click Browse to se-
lect one, or click the Point & Shoot 
button to link to a script file in the 
Project window.

Click Edit to open the Script Builder 
and start scripting.
13
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The following script builder appears after clicking the Edit button in the Body Script Inspector.

The Java Script Builder

Java Applets

GoLive CyberStudio supports Java applets. Drag the Java Applet icon from the Palette and 
drop it in your document. The context-sensitive Inspector window, now titled Java Applet 
Inspector, will allow you to configure your animation. 

Java Applet Icon, Java Applet Placeholder and Java Applet Inspector

Click here to select a class or script 
element.

Drag your selection …

… and drop it in the main window.

Drag the “Duke” icon from the 
Palette onto your document.

Drop it to insert this Java applet 
placeholder.

Watch the Java Applet Inspector appear 
in the Inspector window.

Click here to type in the code base.
Click Browse to select an applet or click the 
“@” button to link to an applet in the Project 
window.

Click the Play button to view the animation.

Use this section to adjust geometry.}
Click here to name the applet.

Click other tabs to view more options.
14
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Layout Grids

Just like a conventional desktop publishing application, GoLive CyberStudio lets you posi-
tion objects anywhere you want to. The Web browser just needs to support tables (And 
which state-of-the-art browser doesn’t?) to display elements positioned with 
GoLive CyberStudio layout grids. 

To insert a layout grid, simply drag the Layout Grid icon from the Palette and drop it in your 
document. The context-sensitive Inspector window, now titled Layout Inspector, will let you 
set various options for the magnetic grid. 

After inserting the grid into your document, you can rely on its ability to grow as you add 
content, or you can resize it to meet your needs. To resize, simply double-click the left or 
right edge of the grid to display its resize handles. Click the desired handle, then drag in the 
desired direction to resize the grid.

You can now start to arrange elements on your layout grid. For an example, see the follow-
ing section Layout Text. 

Layout Grid Icon, Layout Grid and Layout Inspector

Check or uncheck the Visible boxes 
to show or hide the grid.

Drag the Layout Grid icon from the 
Palette onto your document.

Drop it to insert this layout grid. Watch the Layout Inspector appear in the 
Inspector window.

Type in the width and height of 
the layout grid here.

Check the Snap boxes to make the 
grid attract objects.

Type in the horizontal and vertical 
divisions of the layout grid here.
15
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Layout Text

Just like any other element, you can position text in layout grids to make it appear at the 
desired location when being viewed with the browser. To insert text into layout grids, sim-
ply drag the Layout Textbox icon from the Palette and drop it in the desired layout grid. 

After inserting the text box into your document, you can rely on its ability to grow or resize 
it to meet your needs. To resize, click the left or right edge of the text box to display its resize 
handles. Click the desired handle, then drag in the desired direction to resize the box. After 
resizing, you can proceed to type in text. 

Layout Text Box Icon and Layout Grid with Layout Textbox Inserted

Images

GoLive CyberStudio supports images and client-side clickable image maps. To insert an im-
age, drag the Image icon from the Palette and drop it in your document. The context-sen-
sitive Inspector window, now titled Image Inspector, will allow you to set options for your 
image. 

Image Icon, Image Placeholder and Image Inspector

Drag the Layout Textbox icon from the 
Palette onto your document.

Drop the text box in your layout grid, po-
sition it by means of the layout grid, re-
size it, and type in text.

Use this resize handle to change the 
size of the text box.

Drag the Image icon from the Pal-
ette onto your document.

Drop it to insert this Image 
placeholder.

Watch the Image Inspector appear in the 
Inspector window.

… click Browse to select an image file or click 
“@” to link to an image in the Project window.

Use these options to adjust overall 
image geometry.}

Click other tabs to view more options.

Type in the Resource Locator here…
16
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Image Maps

GoLive CyberStudio provides a convenient means of inserting and editing client-side click-
able image maps. 

To insert a clickable map, just drag and drop the Image icon onto your document window, 
select an image, Click the Map tab rider in the Image Inspector window. In the Map tab rider, 
check the Use Map checkbox and name the clickable map. 

To edit the hotspot area of the image map, use the editing tools In the Map tab rider. The 
toolbar features various map-specific buttons that let you shape and color your map area. 
You can also link the clickable map with the desired resource.

Client-Side Clickable Image Map and Image Inspector

This is how a reactangular map area us displayed in your document window.

Use the Map Editor tools to shape, link and color your click-
able map areas.

Type in the destination URL here …

… click here to select a local resource or “@” to drag and link 
to a file icon in the Project window.

Click the Map tab rider to edit clickable image maps.

Type in the map name here.

Check the Use Map checkbox to turn an image into a client-
side clickable image map.

Type in target area on the destination page here or select a 
target from the popup menu.
17



The Palette and Inspector Windows GoLive CyberStudio Try Out Manual
Plugins

GoLive CyberStudio supports a variety of plugins, for example QuickTime, QuickTime VR 
and QuickTime 3D plugins. Drag the Plugin icon from the Palette and drop it in your docu-
ment. The context-sensitive Inspector window, now titled Plugin Inspector, will allow you to 
configure your multimedia page element now. When finished, click the the Play button to 
check it out!

Plugin Icon, Plugin Placeholder and Plugin Inspector

Tables

GoLive CyberStudio supports multi-column, multi-row tables. Drag the Table icon from the 
Palette and drop it in your document. The context-sensitive Inspector window, now titled 
Table Inspector, will allow you to configure your table with its rows and columns before you 
start typing in text. To resize rows and columns, use the Inspector or Click the border of the 
cell and drag.

Table Icon, Table Placeholder and Table Inspector

Drag the Plugin icon from the Palette 
onto your document.

Drop it to insert this Plugin place-
holder.

Watch the Plugin Inspector appear in 
the Inspector window.

… click Browse to select a media file or “@“ 
to link to a media file in the Project window.

Use this section to adjust the overall 
geometry and the display properties of the 
media item.}
Click here to type in an object name.

Click other tabs to view more options.

Type in the file name here …

Click this button to play back the media file. 
(Requires the appropriate plugin extension 
in the GoLive CyberStudio “Plugins“ folder.)

Drag the Table icon from the Palette 
onto your document.

Drop it to insert this Table place-
holder.

Watch the Table Inspector appear in 
the Inspector window.

Use this section to set cell parameters.

}

Check the Caption box to enable the cap-
tion, then use the popup menu to place it 
above or below the table.

Click other tabs to view more options.

Use this section to control table layout.

}
Use this popup menu to align the table.
18



GoLive CyberStudio Try Out Manual The Palette and Inspector Windows
Horizontal Lines

GoLive CyberStudio supports solid or 3D horizontal lines, also referred to as rules. Drag ei-
ther Line icon from the Palette and drop it in your document. The context-sensitive Inspec-
tor window, now titled Line Inspector, will allow you to resize your line and toggle between 
solid and 3D line shapes. 

Line Icons, Line Types and Line Inspector

Horizontal, Vertical and Block Spacers

GoLive CyberStudio supports horizontal, vertical and block spacers to help you structure 
your page layout. Drag either Spacer icon from the Palette and drop it in your document. 
The context-sensitive Inspector window, now titled Spacer Inspector, will allow you to resize 
and reshape the spacer to meet your needs. 

Spacer Icons, Spacer Types and Spacer Inspector

Drag either Line icon from the Palette 
onto your document.

Drop it to insert a solid or 3D hori-
zontal line.

Watch the Line Inspector appear in the In-
spector window.

Click either button to toggle line shape.

Use this section to set line geometry.

or

}
Click either button to set line aligment.

Drag either Spacer icon from the Pal-
ette onto your document.

Drop it to insert a horizontal or ver-
tical spacer.

Watch the Spacer Inspector appear in the 
Inspector window.

Click either button to select 
spacer orientation.

Use these fields to resize the spacer.

Horizontal

}
Use this popup menu to set spacer aligment.

}

Vertical

Block
19
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Unkown Start and End Tags

GoLive CyberStudio supports unkown start and end tags to ensure unlimited compatibility 
with future Web browsers. Drag the Tag icon from the Palette and drop it in your document, 
then define the new tag and its attributes in the Tag Inspector. Type in your text or insert 
your content, then add and name the End Tag accordingly. 

Tag and Endtag Icons, Tag and Endtag Boxes and Tag Inspector

Anchor Insertion from the Palette

GoLive CyberStudio lets you insert anchors in two ways. The first way is to drag the Anchor 
icon from the Palette, drop it in your document and name the new anchor in the Anchor 
Inspector window, so it can be referenced by links. 

Anchor Icon, Anchor Symbol and Anchor Inspector

Drag the Tag and End Tag icons from 
the Palette onto your document.

Drop both icons to insert a pair of 
unknown tags.

Watch the Tag Inspector appear in the 
Inspector window.

Type in the tag name here.

Type in the new attribute and its value here.
Click this button to add new attríbutes.

View the tag attríbutes and values in the 
attribute list field.

Click this button to delete the selected at-

Drag the Anchor icon from the Palette 
onto your document.

Drop it to insert this Anchor symbol. Watch the Anchor Inspector appear in the 
Inspector window.

Type in the anchor name here.
20
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Point-and-Shoot - Inserting Links and Anchors

Alternatively, you can use one of the “red-hot” GoLive CyberStudio features and save time 
by point & shoot inserting an anchor along with a link. Here is a short description of how 
to use this feature:

1 Click and drag to select the text you wish to use as the origin of the link. 

2 Command-Click the selected text and drag the resulting line to the desired destination. 
The destination may be on the same page, in another on-screen window, or even in the 
Project window.

3 Release the mouse button to insert the anchor and attach the link in the process.

The following screenshot illustrates the process of inserting a link and anchor combination.

Point & Shoot Insertion of a Link and an Anchor

Click and drag to select 
the origin of the link, 
then command-click 
and drag the link 
where you want it to 
go.

Drop the link at the de-
sired destination and 
watch the anchor sym-
bol appear.
21
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Comments

GoLive CyberStudio lets you insert comments in your page. Drag the Comment icon from 
the Palette and drop it in your document. The context-sensitive Inspector window, now ti-
tled Comment Inspector, will allow you to type in descriptive text for future reference. 

Comment Icon, Comment Symbol and Comment Inspector

Forms Tags

The Forms tab of the Palette contains a complete inventory of tags to assist you in building 
fully functional forms. Tag insertion is a simple drag & drop process, assisted by a context-
sensitive Inspector window.

Palette Window with Forms Tab Selected

Drag the Comment icon from the Pal-
ette onto your document.

Drop it to insert the Comment symbol. Watch the Comment Inspector appear in 
the Inspector window.

Type in your comment here.
22
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The following table lists the individual tags in the Forms tab and explains their functions.

Symbol Function

Click this icon to insert the Forms tag, identifying the current section as a form.

Click this icon to insert a checkbox.

Click this icon to insert a radio button.

Click this icon to insert a Submit button.

Click this icon to insert a Reset button.

Click this icon to insert a list box.

Click this icon to insert a file browser.

Click this icon to insert a hidden text field.

Click this icon to insert an image, for example a button that helps the user navigate through the form.

Click this icon to insert an encryption key generator.

Click this icon to insert a password entry field.

Click this icon to insert a single-line text field.

Click this icon to insert a scrollable multi-line text area.
23
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Header Tags

The Header tab of the Palette contains a complete inventory of tags for exclusive use in the 
head section of the page. Tag insertion is a simple drag & drop process.

Palette Window with Header Tab Selected

The following table lists the individual tags in the Header tab and explains their functions.

Symbol Function

Click this icon to insert the IsIndex tag and identify the page as a searchable index.

Click this icon to insert the Base tag and set a default URL for a referenced page.

Click this icon to add keywords to your page that can be accessed by search engines.

Click this icon to insert the Link tag abd define the relationship of the current page to 
parent or child pages.

Click this icon to insert the Meta tag and add special information to your document, 
for example the physical location of the file.

Click this icon to insert the Refresh tag and instruct the browser to update the page at 
a selectable interval.

Click this icon to insert Unknown Start and End tags for new header items that are not 
yet supported by the current version of GoLive CyberStudio.

Click this icon to insert a comment.

Click this icon to insert a script that is run while the page is still loading.

&
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Frames and the Frames View

The Frames tab of the Palette contains a complete inventory of frames and frame sets. Drag 
& drop insertion of frames is supported in the Frames view and assisted by the Frame Set 
Inspector, which lets the user make general settings for HTML frames. Frame-specific set-
tings, such as the resource locator of the file you wish to appear in an individual frame, can 
be set in the Frame Inspector.

Palette Window with Frame Tab Selected

The screenshot below shows the GoLive CyberStudio screen while the program is in the 
Frames view, complete with the Palette and Frame Inspector windows. 

Frame View and Frame Set Inspector

Drag a frame or frame 
set from the Palette onto 
the document window.

Click here to switch to 
the Frames View.

Use the Frame Inspec-
tor to resize and name 
the currently selected 
frame, connect it with 
a file, and set its scroll-
ing and resizing prop-
erties.

Use the separators to resize the frames 
relative to each other.
25
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Previewing Your Work
GoLive CyberStudio Preview module lets you preview your work and test your links without 
launching a browser, giving you a very realistic visual impression of your page layout. 

The Preview Screen

Additionally, clicking the View in Browser button lets you launch one or more Web browsers 
at a time, allowing you to check out more advanced features. The Browsers group of options 
in the Preferences dialog lets you select multiple browsers for previewing your pages. 

Multiple Browser Selection in the Preferences Window

Click Preview to launch GoLive 
CyberStudio’s unique preview mode.

Click the View in Browser button to 
launch one or more browsers for 
previewing.

Select multiple browsers in the Browsers 
pane of the Preferences window…}

… by clicking Add and choosing an applica-
tion in the subsequent file selection dialog 
box.
26
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The Color Picker
The Color Picker window provides comprehensive color support. To color an object, select 
a color from the tab of your choice, then drag the color from the preview pane of the color 
picker onto the object. 

For a list of available color spaces, see the illustration below.

The Color Picker and its Color Options

Click this tab rider to view RGB colors.

Click this tab rider to view CMYK colors.

Click this tab rider to view the gray scale.

Click this tab rider to view indexed colors.

Click this tab rider to view Apple system colors.

Click this tab rider to view Web colors.
27
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Managing Web Sites 
GoLive CyberStudio features a comprehensive set of project management tools to assist the 
user in building and and maintaining Web sites. With its completely new approach to site 
management, GoLive CyberStudio greatly reduces the site administrator’s workload. 

State-of-the-art technology, such as point & shoot linking, graphic displays of document hi-
erarchies, import capability for home pages plus referenced files, automatic URL reference 
parsing and continuous link integrity validation, saves precious time, increases productivity 
and allows you to keep up with the fast pace dictated by the Web.

The Project Window

The Project window is the key to site management. This window allows you to manage the 
files contained in your site. 

The Project window features five tabs labeled Files, Media, URLs, Addresses and Pending:

• The Files tab holds HTML pages, images and miscellaneous objects.

• Themedia tab contains video, audio and other media files.

• The URLs tab stores the Unique Resource Locators used in your project. 

• The Addresses tab serves as a container for E-mail addresses.

• The Pending tab accommodates generic links created in the Site View when designing the site 
(see page 32). The Pending tab works much like a “to do“ list , instructing the user which source 
pages to open to change generic links into physical links pointed at the desired destination.

The Project Window 

Opening the Project Window

To open the Project window, create a new project by selecting the New Project command 
from the Files menu, add files, URLs and addresses and save it, or simply use the Open com-
mand from the same menu to load an existing project.

Click this tab rider to view the 
HTML pages used in your 
project.

Click this tab rider to view the 
URLs used in your project.

Click this tab rider to view the 
E-mail addresses used in your 
project.

Click this tab rider to view the 
media files used in your 
project.

Click this tab rider to view 
pending links for an open Web 
page..
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Adding Files

There are several ways of adding files to the Project: To add existing files, drag the file icon 
from the Finder onto the Files tab or select the Add Files… command from the Project 
menu. 

A way of adding generic pages is shown on page 32.

Opening Files from the Project Window

To open files from the Project window, simply double-Click the desired icon in the Files list 
or use the Open command from the File menu.

The Reference Inspector

Accompanying the Project window is the Reference Inspector, which provides specific infor-
mation on the file currently selected in the Project window. 

The Reference Inspector Window

The Page tab contains options for Web pages, such as file status, home page status and publish.

The File tab contains file-related options and information, such as Finder label, stationery 
status, creation and modification dates, etc.

The Content Tab allows for previewing image and media files, for example PICT, 
QuickDraw 3D, Adobe PhotoShop, GIF, JFIF and QTIF (using QuickTime) files.

Use the File tab to view Finder-related in-
formation and options.

Use the Content tab to preview images 
and media files.

Use the Page tab to view general Web 
page options.
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The Project Tab - Palette Support for Projects

The Project tab of the Palette window contains a selection of generic site elements. To create 
a new site element, drag any Project tab icon (with the exception of the generic page icon) 
onto the corresponding tag of the Project window, then add a definition in the correspond-
ing Inspector window. 

Palette Window with Project Tab Selected

The following table lists the individual tags in the Project tab and explains their functions.

Symbol Function

Drop this icon in the Site View to insert a new generic page. When you are finished de-
signing your site, double-click to open the new page and fill it with content.

Drop this icon in the Project window to insert a new URL, then specify the URL in the 
corresponding Inspector window. 
Dragging a URL from the main window of your Web browser inserts the same icon 
complete with a definition.

Drop this icon in the Project window to insert a new E-mail address, then specify the 
address in the corresponding Inspector window.
Dragging an address from the address book of your Web browser inserts the same icon 
complete with a definition.

Drop this icon in the Project window to insert a group as a container for pages. Name 
the group, then drag the desired pages and drop them on the group icon.

Drop this icon in the Project window to insert a group of media files. Name the group, 
then drag the desired movie, sound and animation files and drop them on the group 
icon.

Drop this icon in the Project window to insert a group of URLs. Name the group, then 
drag the desired URLs and drop them on the group icon.

Drop this icon in the Project window to insert a group of E-mail addresses. Name the 
group, then drag the desired addresses and drop them on the group icon.
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The Site View

Invoked via the Show Site command from the Project Menu, the Site View presents an overview 
of the hierarchy within your site, using default document icons and a spiderweb metaphor to 
demonstrate how the links branch out from the home page to lower-level pages. Beyond its 
mere viewing functionality, however, this window can also be used as a site designer, allowing 
you to lay out the architecture of your site by adding new generic pages and links. 

The Site View

GoLive CyberStudio hierarchical site view is based on a typical parent, child and sibling ap-
proach: The home page is the parent to all pages on the next lower level, which are in turn 
children of the home page. The pages on the lower level are siblings to each other. The 
hierarchy of your Web site is represented by the solitary home page icon at the top and sev-
eral rows of icons below it, depending on its complexity.

The Graphics Inspector 

Accompanying the Site View is an Inspector that lets you build the site view from the home page 
(Use this option only after selecting a home page in the Project Inspector!), zoom in and out of 
the graphic and adjust display properties, such as grid width, geometry and color.

The Graphics Inspector

The home page is the parent page.

Referenced pages are children of the parent 
page and siblings to each other.

Interconnecting lines represent for-
ward links.

Horizontal lines represent backward links 
between siblings or between a child and a 
parent. 

Click here to build the site view after defining a home page.

Click here to toggle link shape.
Click here to zoom in and out.

Use the grid options to customize your site view.

Click here to clean up your display.

}
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Adding Generic Pages in the Site View

The Site View provides a convenient way of designing the architecture of your site before 
adding any actual content to your pages. To that end, GoLive CyberStudio lets you insert ge-
neric pages, that is, blank or stationery pages serving as placeholders within the structure 
of your site. 
Generic pages enable you to build the architecture of your site from scratch by creating an 
“architectural model“. After finishing the design, you can double-click each generic page 
and start filling it with content. Alternatively, you can base your site design on existing pag-
es and add generic pages to check out how they fit in your site.

Adding Generic Pages to the Site View

To add a generic page, you can also drag a stationery file from the Project window onto the 
Site View.

Adding Generic Links in the Site View

The Site View also supports the Point & Shoot insertion of generic links. Generic links are a 
site design tool that lets you add “placeholders links“ to your pages in order to edit them 
when you are done with your site design. The generic links for the current page are dis-
played in the Pending tab of the Project window. To complete your project, you will have to 
attach these generic links, using the current page as the destination (see page 28)

Point & Shoot Linking in the Site View

Option-Click the page you 
want to add a child to.

… then release the mouse button to insert a new child page.

Drag the file icon…

Command-click the page you want to use as 
the source of the link…

… and drag to the desired destination.
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The Link View

Invoked via the Show Site command and clicking the Link View tab rider, the Link View func-
tions much like a magnifying glass that permits you to zoom in on selected items in your 
site. The resulting spiderweb view lets you inspect individual pages and the links they main-
tain with parent and child pages as well as resources.

Viewing the Homepage in The Link View

The Link View also allows you to walk through the hierarchy of your site by clicking the file 
icons successively—from the homepage right down to the last image. 

The Link Inspector 

Accompanying the Link View is a context-sensitive Inspector window that gives you control 
over what is displayed in the link view. You can show or hide individual items immediately 
by checking or unchecking the appropriate options.

The Link View Inspector

The large icon indicates the current 
page you have zoomed in on.

Small icons indicate pages or resources 
referenced by the current page.

The threads of the spiderweb represent 
links.

Use these options to show or hide entire classes of objects.

Click here to hide or show forward links.

Click here to hide or show backward links.

}
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Project Preferences

The Preferences command in the Edit menu contains a variety of useful settings that let you 
control GoLive CyberStudio’s behaviour in any given situation. Here are just a few examples 
of the options offered by the Preferences window.

Options for Adding Files

GoLive CyberStudio offers various options for adding files to a project. 

Before you drag existing files onto your Project window, you can instruct 
GoLive CyberStudio to add them either as standalone files or together with all referenced 
objects. 

For example, you can import the home page of an existing site to create a new project and 
have GoLive CyberStudio import all referenced images, plugins, external references, mail 
addresses, etc. in the process.

Multiple Browser Selection in the Preferences WIndow

Check this box and type in a numeric value in 
the box below for the number of hierarchy lev-
els you wish to import, or click Infinite.
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HotSauce File Generation and Viewing

Plugin technology enables GoLive CyberStudio to support Apple’s proprietary MCF (Meta 
Content Format) technology. Also known as HotSauce or ProjectX, this extension allows you 
to add a 3D “fly-through” view to your Web site.

To write an MCF file, simply select the Create HotSauce command from the Project menu 
and save the file in your project folder. (Please note that this command is only available 
when the Project window is selected.)

To view the MCF file, open the Content tab in the Reference Inspector window and use the 
mouse to navigate through the 3D space.

Fly-Through View of the Local Site
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